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Adobe Illustrator Essentials

Adobe Illustrator is a vector based imaging programme 
used by graphics  and creative professionals 
to generate scaleable graphics for all types of 
applications. It combines the ease and speed of 
using a computer with the control of fine detail 
formerly only possible when drawing by hand.

Illustrator is relatively easy to learn and gives 
you total control over the creation of artwork.

Whether you have scanned or hand drawn or 
painted an image,  the image is usually defined by 
arrangement of dots (pixels).But in Illustrator you 

can generate an image that not only consists of 
dots but also of lines and curves,  each  of which 
has its own mathematical definition (vector).

Because of this graphics created in Illustrator 
can be used at any size and retain their crisp 
appearance, it is the tool of choice for Graphic 
Designers, Fashion & Textile Designers, packaging 
and label designers as well as illustrators.

Combined with Adobe Apps Illustrator 
provides an intuitive environment for 
creation from paper, tablet to desktop.
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What are vector graphics? 
Computer graphics fall into two main categories 
-- vector graphics and bitmap (pixel based) images. 
Understanding the difference between the two 
helps you create, edit, and import artwork.

In Illustrator, the type of graphic image can 
have important effects on your workflow. For 
example, some file formats only support bitmap 
images and others only vector graphics. 

Graphic image types are particularly important when 
importing or exporting graphic images to and from 
Illustrator. For example, linked bitmap images cannot 
be edited in Illustrator. Graphic formats also affect how 
commands and filters can be applied to images; some 
filters in Illustrator will only work with bitmap images.  

Adobe Illustrator creates vector graphics made of lines 
and curves defined by mathematical objects called 
vectors. Vectors describe graphics according to their 
geometric characteristics. For example, a bicycle 
tire in a vector graphic is made up of a mathematical 
definition of a circle drawn with a certain radius, 
set at a specific location, and filled with a specific 
colour. You can move, resize, or change the colour of 
the tire without losing the quality of the graphic.  

A vector graphic is resolution-independent -- that 
is, it can be scaled to any size and printed on any 
output device at any resolution without losing its 
detail or clarity. As a result, vector graphics are the 
best choice for type (especially small type) and 
bold graphics that must retain crisp lines when 
scaled to various sizes - for example, Logos.

Type of work ideal for Illustrator
There are some types of work that are much 
better created in Illustrator rather than an 
image editing program like Photoshop.

• Logos, Icons and Symbols

• Infograpnics

• Illustrations using broadly flat colour

• Maps

• Large Format Posters

• Packaging and Labels

• Textile design where repeat patterns are required

• Technical Drawings

• Point of Sale and Merchandising

Businesses can create impressive graphs 
using Illustrator’s Graph tools with confidence 
knowing they will scale for any use.

Marketers can use the impressive Type tools and 
other type features to design single-page ads.

Designers create logos and other marketing 
graphics that need to be scalable in Illustrator. 

In short, Illustrator is a comprehensive vector 
program that can be difficult to master. but 
provides exceptional tools to do the work.
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Illustrator is truly flexible and provides the tools you need 
to start creating illustrations. Before you begin working in 
Illustrator take some time to familiarise yourself with the 
Tools and Illustrator Workspace. 

Before you begin think about what it is you are trying to 
achieve and, how it will be presented or printed. 

Perhaps sketch your idea on paper or directly using one 
of the excellent Adobe Apps - such as Illustrator Draw 
or Photoshop Sketch - these allow you to take your idea 
directly into Illustrator.

Before you Start
• Sketch your idea & make some style decisions 

• Don’t use too many type faces or sizes

• Plan all elements within a job

• Prepare any extra photos or graphics

The Tools
Familiarise yourself with ALL the tools - whilst certain 
tools appear to do the same thing (ie. curves, pen, pencil  
or curvature ), another tool may actually be more suitable 
or quicker to use.

The illustrator Tool bar includes selection tools, editing 
tools, drawing and painting tools, viewing tools, etc. 
These are covered later in this manual.

• Click on a Tool to select that tool.

• By clicking and holding down the mouse button on 
the toolbox with a triangle at the bottom right corner, 
you can find the additional hidden tools. 

Panels
Illustrator Panels are located 
within the Window menu as 
well as default Panels which 
appear on the right based on 
a Workspace.. If a Panel is not 
visible, you can open it from the 
Window Menu and as you select 
a panel, it appears on screen. 

By clicking the different tabs 
on the panel groups you can 
access the different functions.

Illustrator Fundamentals



© 2017 COMPUTER GRAPHICS TRAINING 7

NOTES

Adobe Illustrator7

Paths & Anchor Points
Every shape or line you draw is known as a path. Paths 

are lines, which can be straight or curved. Paths have 
anchor points which can be straight or curved and which 
can be used to alter the shape.. Every shape has an outer 
path with a default stroke (line) value (1pt) and can be 
filled with colour using the swatches panel.

Closed paths are objects such as circles or stars, in 

which the start and end of the path are the same point. 

Open path objects do not have the same start and end 

points.

Anchor points are the points 

that control the direction and 

curvature of that path as well 

as the start and end points. 

Artboards
Every document created in Illustrator starts with an 
Artboard - an illustrator file can contain many artboards.

Artboards can be any size and can be amended during or 
after a graphic is created, so that the artboard can fit the 
graphic.

When you create a new document the artboard will be 
the size specified at document creation.

Creating additional Artboards
Locate the Artboards 
Panel, depending on 
the Workspace you 
selected, this is found 
as an additional tab 
next to Layers, or you 
can open from the 
Window Menu,

Click the New Artboard icon (bottom of panel) to create 
a default size artboard or choose the options for the 
panel (top right) to duplicate, arrange or choose artboard 
options.. By default each artboard is suffixed 1,2 etc.

Renaming artboards
Artboards can be renamed. Double-click the artboard 
name and overtype or choose artboard options (top 
right) and rename from there.

Layers
Organize artwork with Layers and keep your artwork 
flexible and organized as you create the different 
elements for your document. See Layers.

TIP
It is advisable to give 

artboards specificx 

names so you can 

easily identify them and 

switch between them

Open Stroked Path

Open Filled Path
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Before you begin familarlise yourself with the workspace environment, 

ArtboardPa
st
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rd

Tools

File Name / Tab

Menus

Control Panel

Cloud / Library

Panels

Workspace

The Illustrator Workspace
Application Frame



© 2017 COMPUTER GRAPHICS TRAINING 9

NOTES

Adobe Illustrator9

Control Panels
This is the primary formatting panel with icon 
based formatting options and dependant 
on the type of content selected.

The Control Panel provides icon-based formatting options 
for items and content placed onn the artboars. Fields 
and controls displayed in the Control Panel change 
depending on the active object. You can choose to move 
the Control Panel anywhere (though it is set to the top by 
default) by clicking and dragging on the left hand side.

The Control Panel is active by default but if not 
visible – choose Control from the Window menu.

Menus 

Illustrator menu commands 
are accessed by placing the 
pointer over a menu, clicking 
once depressing the mouse 
button to highlight a command 
– then releasing the mouse.

Menu commands that are dimmed 
are not available until a relevant 
action is performed. Commands 
with three dots after the name 
indicates there is submenu.

To the right of menu commands 
are the keyboard short-cuts.

Tools
Tools provide the way of selecting, drawing and 
working on elements within an artboard.

Panels
Panels provide specific formatting options 
related to the type of content.

The Window Menu deals almost exclusively with 
showing and hiding the various Panels used whilst 
you work. Some Panels are also accessible from 
menu items, like the Pathfinder from Object Menu. 

Workspace
The Workspace determines what tools and panels 
are opened when you start a document. 

There 8 workspace options each 
that open panels which relate to 
the type artwork undertaken.

Choose from, Automation, Essentials 
(the default), Layout, Painting, Printing 
& Proofing, Tracing, Typography 
and Web. You can also ccustomise 
& create a new workspace.

The Pasteboard
 To the left and right of each artboars is a pasteboard 
area which provides a work area for creating, 
moving or storing graphics during creation.

TIP
Any text or graphic 

elements can be 

temporarily placed on 

the Pasteboard prior 

to using them on the 

document page but 

remember to remove 

them before printing 

the document, as they 

may unnecessarily 

increase the file size.
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Glossary of Terms 
Alignment
Position of text in relation to the box frame.

Ascender
The portion of the text that rises above its main body, such as b,d,f,h,t

Additive primary colours
Red, green and blue, which are the three colours used to 

create all other colours when direct, or transmitted, light is 

used (for example, on a computer monitor). They are called 

additive primaries because when pure red, green, and blue 

are superimposed on one another, they create white.

ASCIl
Acronym for American Standard Code for Information 

Interchange. A standard that assigns a unique binary 

number to each text character and control character.

Aspect ratio
The height-to-width ratio.

Attribute
Particular qualities of the text or typefaces.

Auto-Leading
See Leading. In Quark Auto leading is 20% of the point size.

Background Colour
The colour fill used in the background of a box.

Baseline
The invisible line upon which the bottom of  text is aligned.

Bitmapped image
The simplest type of image. A bitmapped image is 

black and white and formed by a number of dots.

Bleed
A page element (usually colour) that extends 

to the edge of a trimmed page.

Blend
See Gradient Fill.

Box Skew
Boxes in Illustrator can be skewed or angled 

using the Modify box option.

Button
A push-button type control in a submenu to 

confirm, activate or cancel and option.

Camera Ready Artwork
A finished page or document ready for reproduction.

Cap Height
The height of a Capital letter measuring from baseline 

to the top of the Capital or uppercase letter.

CMYK image
The four process colours used in printing: Cyan, magenta, yellow 

and black. A four-channel image containing a cyan, magenta, yellow 

and black channel. These are known as subtractive, in that when 

Cyan, Magenta and Yellow are combined they produce black.

Colour separation
An image that has been separated into the four process 

colours of cyan, magenta, yellow and black (CMYK), 

and is then printed on four separate plates, each plate 

representing one of the four process colours.

Continuous-tone image
An image containing gradient tones from black to white.

Copyfitting
Determining how much copy will fit in a given space or 

calculating the typeface size based on the amount of copy 

supplied and the number of pages it must fit in.

Crop
To select part of an image and discard the deselected areas.

Crop marks
The marks that are printed near the edges of an image 

to indicate where the image is to be trimmed.
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Dot gain
In printing a dot can print larger (spread), 

causing darker tones or colours. 

DPI
Dots per inch; a measure of resolution.

Duotone image
A grey scale image that uses one or more inks to reproduce highlights 

and shadows. Duotone mode images include monotones (one ink), 

duotones (two inks), tritones (three inks), and quadtones (four inks). 

Emulsion
The photosensitive layer on a piece of film or paper.

Gradient fill
A fill that displays a gradual transition from colour to another. 

Gradient fills are created using the Colour Palette.

Grey scale image
A single-channel image consisting of up to 256 levels of 

grey, with 8 bits of colour information per pixel.

GREP
 Is a command line text search utility originally written for 

Unix, and the acronym means globally search a regular 

expression and print. Essentially, GREP in Illustrator allows 

you to use code to find and edit or style text through the 

Find/Change dialogue box or Paragraph Styles.

Halftone
The reproduction of a continuous-tone image, made by using 

a screen that breaks the image into various size dots.

Kern
To adjust the character spacing in type.

Kilobyte
Equal to 1024 bytes. A kilobyte is often referred to a K.

Leading
The line spacing for type, measured from 

baseline to baseline of the lines of text.

Linear fill
A fill that is projected from one point to another, in a straight line.

LPI
Lines per inch; a measure of resolution.

Moiré Pattern
An undesirable grid like pattern that can result when two 

or more screens are superimposed when printing.

Nudge
Active items can be nudged in 1 point increments using 

the arrow keys on the keyboard. Hold the option key 

down whilst nudging to move in .1 point increments.

Offset Lithography
A printing process that uses metal plates for each colour of 

a spot colour or 4 plates for a process colour document.

Pantone Colours
An International standard for specifying spot colour or 

process colour jobs that match pre-mixed inks (spot).

Pasteboard
The non-printing area surrounding the document page.

Pica
Unit of measurement used in typography. There 

are size picas to an inch, 12 points to a pica.

Point
A basic unit of typographical measurement. A 

point is approximately 1/72 of an inch.

Postscript
A page description language developed by Adobe 

Systems Inc. Postscript is used to describe the fonts, 

graphics and layout in printing process.

Process Colour
The four colour method of reproducing all colours from 

only four inks, Cyan, Magenta, Yellow and Black.

RAM
Random Access Memory, fast computer memory 

that stores information temporarily.

Registration Mark
Symbols placed on artwork or film to ensure 

precision alignment in the printing process.
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Resident Font
A font that is stored in the printers memory.

RGB image
Red, green, blue, this is the default image mode on Flatbed 

scanners and monitors  RGB are known as additive colours, 

that is when each colour is overlaid they produce white.

Smart Quotes
The curly quotation marks that are typographically correct.

Thumbnail
A reduced view of a page - traditionally the thumbnail would be a 

quick sketch an designer might make to outline a possible layout.

TIFF
Tagged image format File. Picture files either 

black and white, greyscale  or colour.

Tiling
The process by which a document larger than the paper it can be 

printed on can be split into sections and then assembled manually.

Tracking
The overall spacing on selected text. By specifying negative or 

positive values the overall character spacing can be adjusted.

Trapping
A slight overlapping that prevents gaps from appearing 

along the edges of an object during the printing process.

Trim
Refers to the process of cutting the edges from the printing 

press sheets to produce the finished ‘trimmed’ page.

Type Family
A group of related typefaces.

Widow
Refers to the last line of a paragraph that falls at the 

top of a column – at all costs to be avoided.

Word Space
The amount of space between words based on the widths specified 

by the typeface designer. Illustrator provides methods for adjusting 

word space. (Hyphenation, Justification, Kerning and Tracking).

WYSIWIG
An acronym for What You See Is What You Get. It refers to the screen 

displays that accurately displays the look of the final printed page.

X-Height
The height of the lowercase characters in a 

typeface as measured from the baseline.



© 2017 COMPUTER GRAPHICS TRAINING 89

NOTES

Adobe Illustrator | Resources89

Illustrator Resources
Illustrator Learning
Adobe Creative Cloud - Illustrator
Adobe Creative Cloud now provides online 
video based tutorials on all the software.

https://helpx.adobe.com/uk/illustrator.htm

Layers Magazine
Layers is the “How-to magazine for everything Adobe”, 
which has a brilliant section dedicated to Illustrator. Here 
you can learn how to use liquid layout, dot-dash stroke, 
story editor and much more. And, best of all, it’s free! 

http://layersmagazine.com/category/illustrator

Computer Arts
The world’s best-selling magazine for digital artists and 
designers. Computer Arts runs regular news, tips and 
tutorials on Illustrator. and how to improve your skills. 

http://www.creativebloq.com/computer-arts-magazine

Inspire Online
Adobe’s own resources centre with some very useful 
scripts/tutorials 
actions and plug-in information

http://create.adobe.com/illustration.html

tv.adobe.com/channel/design/
Adobe TV Channels covering all 
subjects including Illustrator.

Fonts, Colour and Inspiration
Adobe Stock Photos
For copyright free photos,illustrations, 
infographics and icons - can be added as part of 
the Creative Cloud for £19.99 for 10 images per 
month. Pay as you go for £5.99 per image.

istockphotos.com
For copyright free photos, illustrations, infographics and 
icons . Offer subscriptions and pay as you go credits 
which vary per image. Has HUGE range including video.

fontsquirrel.com
Free fonts for designers,even for commercial use!

FontSpring
Fonts for designers, not free, but interesting collection 
some at reasonable/low cost and with wonderful displays 
of us of typography of some fonts, to provide inspiration.

http://www.fontspring.com/

color.adobe.com
Formerly Kuler this is a great free tool for creating, 
editing and sharing colour themes and ties in 
nicely with the Illustrator Color Themes Panel.

www.creativepro.com
Creative community where you can subscribe 
to email news on various subjects/topics

You can also subscribe to various on & 
offline magazines such as DIGIT, Macworld, 
MacUser, Computer Arts and more.
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Illustrations
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FitcluBSTAN’s
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Lightsforhome

LOUNGE    LAB 
DESIGN
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Maps & Floor Plans
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Exhibition & Infographics

SCIENTIFICUPDATE.COM

Provide
Objectivity

Save
Time

Reduce 
Costs

Improve 
Processes

Codexis
Epizyme
Exelixis

Grunenthal
Hovione

Medichem
MMV

Phosphonics
Sai Advantium
Star Pharma

EXPERTISE
where & when you need it...

“Scientific update has provided prompt and 

excellent advice that has enabled us to conduct 

a successful upscale and process validation 

campaign for a novel pharmaceutical.”

CONSULTANCY

E € $ £

CON SU LT I NG
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sive            contemporary

guidance                   s
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Graphics & Patterns
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Inspiration
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